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Document information 
Document information 
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Change log 
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Change for this release: 
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 1 
 Getting started 
This guide provides 
· basic information about Interconnect Mediated Access (IMA) 
· software and hardware requirements 
· instructions for 
· configuring Internet Explorer 
· modifying the java.policy file 
· Internet access to IMA 
This guide is intended for employees of the ISC (Interconnect Service Center), IWSC (Interconnect West Service Center), the LOC (Listing Operation Center), and Competitive Local Exchange Carriers (CLECs). 
This guide assumes you have a background in telecommunications local service. 
IMA is available for use by CLECS in the legacy Qwest territories within the former 14-state Qwest region. 
CenturyLink SYADs 
CenturyLink™ system administrators create IMA accounts for all CLECs, including establishing the first CLEC system administrator and maintaining user profiles. 
CLECs 
CLECs interact with IMA on two levels: 
· administrators create and manage all CLEC user accounts 
· users manage all service requests through IMA 
Connection Guide—IMA 39.0 
1—Getting started 
System security 
IMA allows CLECs access to local service elements of the CenturyLink network and electronic access to its legacy operations support systems (OSS). 
CLECs use IMA to create local service requests (LSRs) and submit them to CenturyLink for processing. LSRs contain the information CenturyLink needs to create service orders for the CLECs. 
System security 
 IMA provides a secure environment for its users. 
	System security 
	Description and access 

	Username and password 
	IMA usernames and passwords for CLEC system administrators are obtained from a CenturyLink system administrator. CLEC system administrators must receive these before they can access IMA. 
CLEC system administrators give CLEC users their username and password. To ensure security, new users should change their individual password the first time they log in to IMA. (See “Changing your password” on page 21.) 
You can change your password at any time. (System administrators can also reset passwords.) 

	User PIN and Corporate ID 
	PINs and IDs are obtained from a CenturyLink Wholesale Markets service manager. Only users who have these credentials can enter the IMA secure environment and access its data, preventing unauthorized persons from gaining access to protected information. 


IMA provides an additional level of security by letting the CLEC system administrators decide the access rights users will need—administrator privileges or user privileges. Access rights define specific privileges users have to operate within IMA. If a user performs the tasks of both an administrator and a user, this user requires two IMA usernames and passwords, one as a user and one as an administrator. 
An administrator can inactivate a user when necessary, preventing the user from accessing IMA and data stored in any of the databases. For more information on CLEC system administrative privileges, see the CLEC System Administrator’s Guide (

HYPERLINK "http://www.centurylink.com/wholesale/ima/gui/index.html" \hhttp://www.centurylink.com/wholesale/ima/gui/

HYPERLINK "http://www.centurylink.com/wholesale/ima/gui/index.html" \h 

HYPERLINK "http://www.centurylink.com/wholesale/ima/gui/index.html" \hindex.html

HYPERLINK "http://www.centurylink.com/wholesale/ima/gui/index.html" \h). 
 IMA hours (Mountain Time) 
	Monday–Friday 
	6 a.m. to midnight 

	Saturday 
	6 a.m. to 9 p.m. 

	Sunday 
	10 a.m. to 7 p.m. 


Connection Guide—IMA 39.0 
1—Getting started 
Additional resources 
Additional resources 
Web sites 
IMA Access 
https://ima.centurylink.com/ima

HYPERLINK "https://ima.centurylink.com/ima" \h Products and Services http://www.centurylink.com/wholesale/pcat/index.html

HYPERLINK "http://www.centurylink.com/wholesale/pcat/index.html" \h CenturyLink E-Business—Digital Certificate Procedures http://ecom.centurylink.com

HYPERLINK "http://ecom.centurylink.com/" \h 
Wholesale Customer Contacts business procedure 
http://www.centurylink.com/wholesale/clecs/escalations.html

HYPERLINK "http://www.centurylink.com/wholesale/clecs/escalations.html" \h Wholesale Resources—IMA 
http://www.centurylink.com/wholesale/ima/index.html

HYPERLINK "http://www.centurylink.com/wholesale/ima/index.html" \h 
Documents 
In addition to this document, CenturyLink provides four other guides to help you use IMA. 
The first three guides are available at 
http://www.centurylink.com/wholesale/ima/gui/index.html

HYPERLINK "http://www.centurylink.com/wholesale/ima/gui/index.html" \h 
· CLEC System Administrator’s Guide—guidelines for managing CLEC users’ accounts 
· Facility-Based Directory Listings Guide—guidelines for submitting orders for facility-based directory listings 
· IMA User’s Guide—guidelines for preparing, submitting, and following up on LSRs 
The fourth guide is available at http://www.centurylink.com/wholesale/training/coursecatalog.html

HYPERLINK "http://www.centurylink.com/wholesale/training/coursecatalog.html" \h: 
· Loop Qualification and Raw Loop Data CLEC Job Aid—guidelines for retrieving raw loop data and for checking whether a loop qualifies (for CenturyLink HSI/Broadband Service or for unbundled ADSL service) 
[image: image4.jpg]‘A‘
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 2 
Requirements 
This chapter describes hardware and software requirements for IMA. If non- IMA applications are running concurrently with IMA, these requirements may need to be increased. 
Note: When a new version of IMA is installed, you must log out of IMA and log back in to continue working. 
Software requirements 
 
 SHAPE  \* MERGEFORMAT 



Important: CenturyLink supports and certifies Windows 7 as the operating system for IMA. CenturyLink recommends you to use Internet Explorer 10.0/11.0 as your browser when running Windows 7. IMA may function using different browsers and Windows operating systems, however, CenturyLink will not be responsible for any problems encountered when using operating systems other than Windows 7. 
 
 SHAPE  \* MERGEFORMAT 



· Microsoft Windows 7 
· Internet Explorer 10.0/11.0 (recommended) 
 
HTML5 compliant browsers such as Firefox, Safari, and Chrome have been tested with the Java applet. These browsers will require plugins to support Java applets – see https://java.com/en/download/help/enable_browser.xml

HYPERLINK "https://java.com/en/download/help/enable_browser.xml" \h. 
• Java Runtime Environment 1.7_u52 thru 1.8_u51 for Internet Explorer. However, CenturyLink recommends that Internet Explorer users upgrade to at least Java Runtime Environment 1.8. 
Hardware requirements (minimum) 
· 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor 
· 1 gigabyte(GB) RAM (32-bit) or 2GB RAM (64-bit) 
· 16 GB available hard disk space (32-bit) or 20 GB(64-bit) 
· DirectX 9 graphics device with WDDM 1.0 or higher driver 
· LAN connection to CenturyLink 
8
· 200 MB free disk space (after all software installation and Windows virtual memory file allocation)  
· Additional memory (RAM) and a faster network connection and CPU may improve performance of IMA. 
Java Desktop Runtime Environment for IMA 
IMA is certified for Java Runtime Environment (JRE) 1.8.0_51 (1.8 u51). Please contact your desktop support if you need the Java RE for your desktop.(Backward compatibility is provided for JRE  1.7.0_52 (1.7 u52).). 
The Java Desktop Runtime Environment (JRE) can be found at http://java.com/en

HYPERLINK "http://java.com/en" \h 
If the Java Desktop JRE has not already been installed, a Java Runtime Environment Not Installed popup window appears in IMA GUI. This appears only when PreOrder/Order/PostOrder is launched for the first time and the Java Desktop Runtime Environment has not been installed. 
Note: It might be possible for an unsupported browser to run the PreOrder/Order/PostOrder GUI after the Java Runtime Environment has been installed. If you encounter problems, however, CenturyLink first recommends that you install IE 10 or IE 11 browser. 
9
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 4 
Connecting to IMA 
If you are accessing IMA over the Internet, several factors external to CenturyLink (such as your Internet service provider—your ISP—and Internet traffic) may impact response time. 
If you’re accessing IMA using a digital certificate, use this URL: 

HYPERLINK "https://ima.centurylink.com/ima" \hhttps://

HYPERLINK "https://ima.centurylink.com/ima" \h 

HYPERLINK "https://ima.centurylink.com/ima" \hima.centurylink.com/ima

HYPERLINK "https://ima.centurylink.com/ima" \h. (CenturyLink recommends that you bookmark this URL.) 
Logging in to IMA for the first time 
The Interconnect Login window ensures that only authorized users access IMA. To log in, you need your corporate ID, username, and password. (You can get this information from your system administrator.) 
See “System security” on page 5. 
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1 In the Interconnect Login window, type your corporate ID, username, and password. (These fields are case-sensitive.) 
2 Click Login. 
The first time you log in to IMA, your password is the same as your username. As soon as you create your personal profile, you should change your password. (See page 21.) 
Creating your personal profile
Creating your personal profile 
The first time you log in to IMA, you must fill in your personal profile before you can go on to other tasks. Your personal profile contains information that CenturyLink uses to contact you. 
Tip: Administrators—you might want create a joint e-mail account and phone number so that all users have access to this e-mail or phone number in case of absence, emergency, or work flow. This group e-mail and phone number can then be entered in the individual user’s profile. 
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1 Fill in the fields. (Floor and Room/Mail Stop are optional.) a For your telephone and fax numbers, use the format 555-555-5555. 
b Fill in your e-mail address, fax number, or both to indicate how you want to receive system notifications. 
2 Click Update Database. (If you click Logout, your profile won’t be saved and you’ll still need to create your personal profile next time you log in.) 
3 Click Return to Main Menu. 
The Interconnect Functions window appears. Depending on your access level, you may see fewer options. 
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Modifying your personal profile 
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Important: Be sure to use buttons within IMA. Don’t use the browser’s buttons (e.g., Back) or you may get an error. 
 
 SHAPE  \* MERGEFORMAT 



Modifying your personal profile 
After you have created and saved your personal profile, you can modify it further as needed. 
1 In the Interconnect Functions window, click User Administration. 
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2 Click in each field to be modified, and change the information. (Remember to use the format 555-555-5555 for the telephone and fax numbers.) 
3 Click Update Database. 
4 Click Return to Main Menu. 
Changing your password 
For security reasons, you should change your password often. 
Changing your password
1 In the Interconnect Functions window, click Set Password. 
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2 Do the following: 
	In this field … 
	Type … 

	Old Password 
	Your current password 

	New Password 
	Your new password (6–8 characters, at least one of which is a number or special character) 

	Re-Type New Password 
	


3 Click Set Password. 
IMA changes your password. 
4 Click Return to Main Menu. 
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 3 
E-business Internet connection 
CenturyLink E-business digital certificates (or digital IDs) are issued for each of your employees. They are required for each personal computer used to access CenturyLink systems via the Internet. 
E-business digital certificate registration is a one-time process and must be renewed every five years. 
You must first request a digital certificate before starting the registration process. 
Requesting a digital certificate 
The CenturyLink E-Commerce group obtains the VeriSign and legacy Qwest cobranded digital certificates needed to access IMA via the Internet. 
The digital certificate process is administered by the CenturyLink WSSA (Wholesale Systems Security Administration) group. This group has responsibility over these certificates for end users, including revocation of a certificate and updating user information. 
To request a digital certificate 
1 Contact your CenturyLink service manager at: 
http://www.centurylink.com/wholesale/clecs/accountmanagers.html

HYPERLINK "http://www.centurylink.com/wholesale/clecs/accountmanagers.html" \h 
Note: You may also go to the Wholesale Systems Web site at http://www.centurylink.com/wholesale/systems/

HYPERLINK "http://www.centurylink.com/wholesale/systems/generalinfo.html" \h 

HYPERLINK "http://www.centurylink.com/wholesale/systems/generalinfo.html" \hgeneralinf

HYPERLINK "http://www.centurylink.com/wholesale/systems/generalinfo.html" \ho

HYPERLINK "http://www.centurylink.com/wholesale/systems/generalinfo.html" \h.html

HYPERLINK "http://www.centurylink.com/wholesale/systems/generalinfo.html" \h 

HYPERLINK "http://www.centurylink.com/wholesale/systems/generalinfo.html" \hfor request information and forms. 
2 Fill out the digital certificate request form. 
3 E-mail the completed form to your CenturyLink service manager. 
The CenturyLink service manager verifies that the information is complete and correct and then forwards your request to WSSA. The WSSA sends your information to ECOM to assign the certificate and PIN information. 
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Important: All digital certificate requests must go through a CenturyLink service manager. Under no circumstances should you e-mail your request directly to the CenturyLink Wholesale Systems Security Administration group. Your request will not be processed. 
 SHAPE  \* MERGEFORMAT 



Downloading your digital certificate
Once your request is processed, the information is updated in the LDAP server and an e-mail reply is sent to you. Please allow a minimum of 48 hours to process and update security databases. 
The e-mail contains the following information you must have before registering your digital certificate: 
· digital certificate number 
· PIN 
· instructions for their use 
Once you’ve registered your digital certificate, you must have the following before you can access IMA: 
· your company’s corporate ID 
· username 
· password 
Downloading your digital certificate 
To begin the downloading process 
1 Go to the CenturyLink Online Service Center Web site at (

HYPERLINK "http://ecom.centurylink.com/" \hhttp://www.centurylinkapps.com/wholesale/cert/index.html

HYPERLINK "http://ecom.centurylink.com/" \h). 
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2 Select Begin Digital Certificate Download Process. 
Downloading your digital certificate
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Important: Digital certificates must be downloaded within 30 days of receipt. Digital certificates not downloaded within this time are removed from the system. If your digital certificate has been removed, you must request a new one. 
 SHAPE  \* MERGEFORMAT 



3 Fill in the User ID and PIN fields and click Accept. 
Note: The client certificate is a personal certificate that identifies an individual CLEC user via a 9 character ID stored in their CenturyLink /Legacy Qwest issued client Public / Private Keys. This client certificate is requested via CenturyLink / Legacy Qwest form and the certificate key Pair is downloaded into the browser on your local machine to encrypt data that is transmitted from you, the CLEC user to CenturyLink. (Note: These certificates are still being issued by the Qwest certification authority (CA)). 
This certificate is stored only on the workstation and browser for that you downloaded it into. Multiple users’ client certificates may be stored on a single workstation. However, if another workstation or a different browser version is to be used by the same user, then either the Public / Private Key pair must be re-downloaded to the new browser version / workstation or the certificate must be exported from the existing location and imported into the new browser/workstation. For this, you must use the Windows certificate export tools and export the client certificate (look for the 9 character user ID) to a USB drive/CD and then on the new workstation/browser use certificate import tools to download the same files from the USB Drive/CD. 
Verifying the installed certificate
4 Click Yes if you receive an ActiveX Control warning. 
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5 Click Yes at the security warning to proceed with installation. 
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When the client digital certificate is fully loaded on the workstation, the registration process is complete. 
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Verifying the installed certificate 
1 Choose Tools > Internet Options in your Internet Explorer browser. 
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Verifying the installed certificate
2 On the Content tab, choose Certificates. 
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3 Double click on the certificate’s name. 
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Modifying the java.policy file
4 View the General tab. 
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5 View the Certification Path tab. 
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Modifying the java.policy file 
 
 SHAPE  \* MERGEFORMAT 



Important: CenturyLink highly recommends that you create a backup copy of the java.policy file. 
 
 SHAPE  \* MERGEFORMAT 



1 Using Windows Explorer, access the java.policy file from the folder C:\ProgramFiles(x86)\Java\jre1.8.0_51\lib\security for a 32 bit Internet explorer or C:\ProgramFiles\Java\jre1.8.0_51\lib\security for a 64 bit Internet Explorer 
2 Select the java.policy file. 
Modifying the java.policy file
3 Select Edit > Copy, then select Edit > Paste. 
A copy of the java.policy file appears in this same folder. 
[image: image31.jpg]EREIEI » Computer » CSDSK(C) » Program Fls » Jov » JWEL7ASL 3 je 1 o ) seeury

= B

Organize »  []Open  Newfolder

e partes T N
B Desicop
% Downlosds
%] Recent Places
B Desktop 2) blacklist cacerts.

] Recentplaces (2)
118 Downloads (2)

& Libraries
Documents
& Music

[ Pictures
H video:

8 Computer

6 etk

java.policy Date modifiec: 6/10/2014 23 PM
POLICY File Size: 253KB

Date crested: 6/10/2014 423 PM

Javausecurity Jovafpolicy  javaws.policy trusted libraries.

Cl

US_export_policy.




 
4 Using WordPad, open the java.policy file. 
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5 Edit the java.policy file by adding the following 3 lines: 
· permission java.util.PropertyPermission "javax.net.ssl.*", "read,write"; 
· permission java.util.PropertyPermission "user.home", "read"; 
· permission java.lang.RuntimePermission "setFactory"; 
Insert these lines at the bottom of the file just above the }; symbol. 
Tip: If you’re reading these guidelines in Adobe Acrobat, you can use the Select Text tool to select the lines of text, copy them, and paste them into the java.policy file. Copy and paste one line of text at a time eliminating the leading bullet. 
6 Save and close the java.policy file. 
If you are unable to access the IMA PreOrder/Order/PostOrder functions after completing the above procedure, do one of the following: 
· If you do not receive an error message, close all active windows and programs and restart your computer. 
· If one of the following error messages displays, follow the instructions and try accessing IMA PreOrder/Order/PostOrder again: 
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If this error message displays, check the java.policy file and make sure the 3 new additional lines you entered are accurate and placed correctly. 
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If this error message displays, check to make sure the certificate password and name are correct. The password is one you previously entered for the certificate or qwest1. The certificate name in your UserID folder must be QwestIMACertificate.p12. 
Note: For digital certificate assistance, call the CenturyLink Wholesale Systems Help Desk (888-796-9102, option 2). 
Importing your digital certificate to Internet Explorer 
This section is for current and new Internet Explorer users and explains how to “move” your digital certificate. 
All requirements for modifying the java.policy file must be completed before continuing. 
1 Open Internet Explorer. 
2 From the Tools menu, select Internet Options. 
3 Click the Content tab. 
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4 Click Certificates. 
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5 Click Import to activate the Certificate Wizard. 
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6 Click Next. 
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7 Type the URL or select Browse to locate your certificate. Your certificate should be located at C:\Documents and Settings under your specific UserID and the file name of the certificate should be QwestIMACertificate.p12. 
8 Click Next. 
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9 In the Password field, type qwest1. This password is case-sensitive. 
10 Click Next. 
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11 Leave the settings at their default positions and click Next. 
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12 Click Finish. 
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The name of the certificate appears in the Certificates list box along with a confirmation message. 
13 Click OK and close all active windows. 
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Step 1: Installing the Root CA Certificate.
If you have not already done so. you must install the Root CA Certficate in your browser. ffyou

already have a Root CA Certificate in your browser. you may proceed to step 2.

« To install the Root CA Certificate, click the button to the right: | _Install Certificate

« On'the popup dialog. select at least Trust this CA to identify web sites and Trust this CA to
identiy email users
« Click OK

Step 2: Information for your Digital ID
The information that you enter here is used to create the public portion of your Digital ID. Fill in all

felds.

User ID

PIN

Step 3: Cryptographic Service Provider
The options in the Cryptographic Senice Provider drop down box are based upon the configuration
of your machine. Choose one of the Microsoft options listed below. We encourage you to choose
the strongest encryption available which is either Microsoft Enchanced Cryptographic Provider v1.0
or Microsoft Strong Cryptographic Provider v1.0

Cryptographic Service Provider
Key Size 1024 ~




